
We’ve made a New Year’s Resolution for 2018 we are hoping we can stick with…  Our Blog page is going to have a new blog each day Monday to 
Friday starting from this week!  If you’re not already a regular reader, maybe you should be from now on. 

Our standard schedule will be as follows:

	 •	Mondays: A to Z of Excel Functions – start your week with a function.  Do you know your COUNTA from your COUNTBLANK?

	 •	 Tuesdays: Power Pivot Principles – we’re starting a new series dedicated to the Power Pivot COM add-in

	 •	Wednesdays: Power Query Pointers – our regular series of ideas for the Extract, Transform and Load (ETL) tool will continue.   
		  Can you clean up your act and keep TRIM?

	 •	 Thursdays: Power BI Tips  – another new series, coming soon to a theatre near you.  If you haven’t used Power BI yet, you really need to start

	 •	 Fridays: VBA Blog – our regular articles on VBA tips and tricks continues unabated.

With the Final Friday Fix, Monday Morning Mulling and other ad hoc blogs appearing from time to time, hopefully there’s something for everyone.  
This is all in addition to our Excel Tip of the Day, and our News and Thought series which will continue to be updated on an (ir)regular basis too.  And 
if you really do want more, do remember there’s the monthly newsletter you can subscribe to at the foot of any SumProduct webpage too.

NEWSLETTER #63 - February 2018

Lots to catch up on this month! With shortened printing 
deadlines for December abbreviating our January newsletter and Microsoft issuing a raft of updates just before the turn 
of the year, our February newsletter sees us well and truly in catch-up mode with what’s been going on – with numerous 
updates for Power BI and Power Query.  Welcome to our biggest newsletter ever!  Don’t be put off if it’s not all for you – 
with so much to report, there’s sure to be something for everyone.

We’ve two big announcements this month too – there’s more on Unlock Excel and our blog series goes daily (on a 
weekday anyway!).  With the usual regular features such as Power Query Pointers, the A to Z of Excel Functions (this 
month COLUMN “rows” to the occasion!) and more Keyboard Shortcuts, there’s plenty to delve into.

Until next month.

Are You Getting it Five Times a Week..?
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As mentioned last month, in conjunction with CPA Australia and Microsoft, SumProduct will be hosting the Excel MVP conference in 
2018 for Australia and New Zealand.  

The events are as follows:

	 •	MELBOURNE 9-10 April
	 •	 SYDNEY 12-13 April
	 •	BRISBANE 16-17 April
	 •	WELLINGTON 19-20 April

We’re pleased to inform you that the official website www.cpaaustralia.com.au/training-and-events/conferences/unlock-excel is now 
fully up and running.  Hope to see you there!

Unlock Excel 2018 Update

Not sure we should be writing about this, but we are keen advocates of learning Excel, data management and financial modelling.  Therefore, it 
seems churlish if we don’t mention that Microsoft has added two Excel tutorials to Excel 2016 for those new to Excel:

1.	 Formula tutorial: This session introduces the concept of a function and steps through some of the more common ones, including everyone’s 	
	 favourite (except us – we hate it), VLOOKUP.  It’s not a bad start though
2.	 PivotTable tutorial: This file provides a step-by-step guide to PivotTables. It’s not bad, but doesn’t mention Recommended PivotTables 	
	 (highlight your data and use the keyboard shortcut CTRL + Q).

They’re easy to access in Excel 2016, simply select ‘File’ from the Ribbon and then click on ‘New’ in the backstage area.  

We look forward to more in due course and hope that Microsoft doesn’t put us out of business!

Microsoft Tutorials for Excel 2016
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Now here is some truly exciting news.  Office 365 is looking to bring in Artificial Intelligence (AI) initiatives into three of its core products: Excel, 
Outlook and Word.  Here at SumProduct, obviously we were most interested in the Excel initiative: Insights.

Each month we’ll reproduce one of our articles on Power Query (Excel 
2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.
com/blog.  If you wish to read more in the meantime, simply check out 
our Blog section each Wednesday.  Last time we looked at M language 
syntax in a simple query.  This month, we add some code to operate on 
each row in a table and show how bulky code can be simplified.

Using the ACCT_Order_Charges_with_Group query edited from last 
month’ article, we will take this a step further and demonstrate how M 

language can be configured to operate on each row in a table.  To do this, 
let’s add a column that is a product of two of my numerical columns, so 
we’ll choose Amount and Order_Line_Number.

Having selected the two columns, in the ‘Add Column’ tab in the 
‘Standard’ section, you can then choose to add a column that multiplies 
these chosen columns:

When you click on ‘Multiply’, a new column called ‘Inserted Multiplication’ is added to the table.  The formula for this step appears in the window 
at the top of the editor:

Insights is a new service that automatically highlights patterns detected 
in your data, helping you discover and analyse new insights such as 
trends, outliers and other useful analyses and visualisations.  It will look 
for noteworthy trends in your data and provide quick summaries with 
PivotTables and charts.  Because this feature is powered by machine 

learning, it will provide increasingly advanced analysis as usage grows.  
It’s just been announced that it has been rolled out in Preview to Office 
365 commercial subscribers enrolled in Office Insiders in the United 
States this month.  Let’s hope it rolls out to the rest of us soon…

An Insight into Insights

Power Query Pointers 
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= Table.AddColumn(#"Sorted Rows", "Inserted Multiplication", each List.Product({[Order_Line_Number], 
[Amount]}), Currency.Type)

Regular readers will notice the ‘#’ which tells Power Query to ignore the spaces in the column names.  The other important part of this formula is 
‘each List.Product’, which is what tells Power Query to apply the multiplication to each row in the table.

As already noted, the column name is not particularly user friendly.  We could rename the column using the buttons, adding another step, but 
instead, to avoid adding another step, we’ll edit the formula associated with adding the new column:

Clicking the tick icon executes the change (as will leaving the change in 
place and clicking anywhere in the table), and the column is added with 
the chosen name in one step. 

We can also add a step and then choose to combine it with another step 
by substituting the whole formula for that step into the next line.  This 
works well if the step being inserted has a short amount of M language 

associated with it; too much substitution can make code hard to follow 
and therefore of less value to share with other users. 

Let’s make a simple change by amending the data type on my newly 
renamed column Order_Line_Number x Amount from ‘Currency’ to 
‘Whole Number’.  On the ‘Transform’ tab, select the column and then 
in the ‘Data Type’ section choose ‘Whole Number’ from the dropdown:
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Having added this step, then open the ‘Advanced Editor’ from the ‘Home’ tab:

The two lines before the ‘in’ statement are:

#"Inserted Multiplication" = Table.AddColumn(#"Sorted Rows", "Order_Line_Number x Amount", each List.
Product({[Order_Line_Number], [Amount]}), Currency.Type),

#"Changed Type" = Table.TransformColumnTypes(#"Inserted Multiplication",{{"Order_Line_Number x 
Amount", Int64.Type}})

At first glance, these may look complicated, but notice that the first line sets the added column to ‘Currency.Type’.  The second line changes this to 
‘Int64.Type’.

So, if we set the type to ‘Int64’ when the column is created, we don’t need the second ‘Changed Type’ line.  We can simply change the type and 
delete the step.  This is not the end of the story though – last time out some of the syntax rules were outlined: one of them is that each step must 
refer to the previous step and another is that the last line before ‘in’ should not have a comma after it.  Therefore, by removing a step manually in 
the editor we have broken the sequence: this needs to be remedied by removing the offending comma:

The step to change type has disappeared and the type on the column is now ‘Whole Number’, as shown next to the ‘Data Type’ section.  We have 
successfully simplified the code behind the query.

The ‘in’ statement currently refers to the line 
I have removed:

in

    #"Changed Type"

We need to change this to refer to what is 
now the last line above it:

in

    #"Inserted Multiplication"

Having done this and removed the comma 
before ‘in’, you can save the changes and look 
at the table: >
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At the risk of it looking like all we do is Power Query (we don’t!), we thought we would share with you our solution to a rather awkward – yet 
common – problem.  We recently got a question from one of our readers that highlights the issue quite well.  Consider the data from the website 
www.quanthockey.com/khl/seasons/2017-18-khl-players-stats.html:

The webpage is nicely set out and contains a table of hockey player 
statistics.  The thing is, the embedded table actually has 17 pages of data 
and let’s say we wish to extract all of this data for analysis elsewhere.

There’s a problem though.  When you click on the second or subsequent 
page of data, the URL for the website does not change.  This seemingly 

defeats Power Query (or Power BI) as URLs for each page of table data 
are required.

So how may we extract all of the data?  To answer this, let’s get there in 
five steps.

Before we move on to our proposed solution, we should first cover how to manually import data from the hockey statistics site.  You should note that 
this method does not yield the complete list; this will be detailed later on.  First, let’s focus on manual extraction.

To manually import the data from this hockey statistics site www.quanthockey.com/khl/seasons/2017-18-khl-players-stats.html using Power Query, 
first open Excel then navigate to the ‘Data’ tab and click on the ‘New Query’ option, then select the ‘Other Sources’ option followed by ‘Web’.

A dialog box will appear, allowing us to insert the URL. Next click ‘OK’.

Power Query Extra: Getting Multi-Page Data from a Web Site with a Single URL

Step 1: Manual Retrieval of Data
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The ‘Navigator’ dialog box will appear, allowing us to select exactly which table to pull data from.  At this point all looks good, however we should 
name the table, so let’s click on ‘Edit’. 

In the ‘Query Editor’ dialog box, we should give our Query a friendly name, say ‘Hockey Data’, then select ‘Close & Load’. 

All seems to have worked well, however upon closer inspection, we can see that Power Query was only able to retrieve the first 50 entries, i.e. 
page 1 of the table data.

All seems to have worked well, however upon closer inspection, we can see that Power Query was only able to retrieve the first 50 entries, i.e. 
page 1 of the table data.

In summary, we have three issues: 

	 1.	We are unable to manually pull all of the data from the website
	 2.	We do not know how many pages of data the website has
	 3.	The webpage does not change its URL when a new page of data is displayed. 

Let’s deal with one issue at a time.
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Let’s address the first issue, then, i.e. the inability to manually retrieve all 
of the data just by importing it using Power Query.  

One proposed solution, proposed by MVP Reza Rad, is to utilise Custom 
Functions in Power Query.  A custom function is a query that is run by 
other queries, for those of you who know Java from coffee beans, and 
is similar to what is known as an Object Method.  The benefit of having 
a custom function is that we can repeat the same steps to a refreshed 
dataset if need be. 

Let’s work through a simple example to illustrate Custom Function’s 
utility.  For example, we wish to retrieve the gross earnings of all of the 
movies released in a particular year, along with their current rank and 
their studio. It does not matter which year we wish to begin with; for 
this example, we shall begin with 2017 (it’s a little too early in the year 
for 2018!):

www.boxofficemojo.com/yearly/chart/?yr=2017&p=.htm

To launch Power Query, we’ll use Excel 2016 and select ‘New Query’ from the ‘Data’ tab:

Then, we’ll adopt the default options and click ‘OK’. 

A dialog box will appear, prompting the selection of the table.  We select ‘Table 1’ then click on ‘Edit’.

Now that we have the Query Editor window open we can define our parameter.  Parameters are needed for custom functions to work. 

Step 2: Custom Functions

http://www.boxofficemojo.com/yearly/chart/?yr=2017&p=.htm 
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We create a simple parameter, set the name to ‘Year’ type to ‘text’ and the initial value to 2017.

We can now add a custom column to ‘Table 1’, click on ‘Table 1’, then on the ‘Add Column’ tab, then ‘Custom Column’. 

We give the custom column a name ‘Year’ and make it equal to the parameter ‘Year’. 
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Be sure to change the custom column’s data type to ‘Text’.

Next, we need to integrate our Parameter into the URL.  If we achieve this, we’ll be 
able to dynamically change the URL, ultimately altering the source of the database by 
the desired year.

With ‘Table 1’ selected, we can click on the setting icon for the ‘Source’ in ‘Applied 
Steps’, viz. 
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Selecting the ‘Advanced’ option, we can Identify the part of the URL that has the date, and enter the parameter in its place instead.  We should also 
include the last bit of the URL after the Year parameter. We do this by ‘Adding Parts’ to the URL. 

Once that is done click ‘OK’.

We now have to convert the query into a function.  To do this, we right click on the ‘Table 1’ query and then select ‘Create Function…’.

Here, we’ll name the function ‘GetMovies’ then click ‘OK’.
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There is now a group folder containing the original ‘Table 1’ query, the Year 2017 parameter and the GetMovies function. 

We have created a copy of the ‘Table 1’ query and called it ‘GetMovies’, from now on every time we call on GetMovies, Power Query will perform 
the same tasks in that order. 

For simplicity then, we will create a simple generator and use the List.Numbers function to create our generator.  To do this, you can create a new 
query by navigating to the ‘Home’ tab in the Query Editor, then ‘New Source’, ‘Other Sources’ and choosing Blank Query.  Then, enter the following 
formula in the formula bar: 

=List.Numbers(2002,16)

The list may then be converted into a table using the ‘To Table’ option located in the ‘Convert’ group. 



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The default conversion settings will suffice.  Lastly, change the data type to ‘Text’. 

With the ‘Query1’ query selected, we can invoke a custom function by going to the ‘Add Column’ tab and select the ‘Invoke Custom Function’ in the 
‘General’ group. 

We will name the new column to ‘GetMovieData’, select the ‘GetMovies’ function and click ‘OK’.
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A new column will be added.

Clicking on each individual Table will reveal the movie data for its corresponding year.  For example, here’s the 2006 data: 

There are some limitations however:

	 •	 Editing the M script of the function will cause the function and query to fail 
	 •	 Custom functions cannot be scheduled to update in Power BI. 

It’s still better than nothing.  

If we expand our dataset,
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this reveals this compiled table with the top 100 movies for each year:

The data still needs some cleaning up however, you can learn how to do that by keeping up with our Power Query Pointers series!

The above deals with manual importation of the data, but what about the page number issue?

Now we create a whole new query: go to ‘New Source’ then ‘Other Sources’ and ‘Blank Query’.  The first line of code to be entered uses the List.
Generate Function: 

=List.Generate ( ()=>

The ()=> function nomenclature essentially says that we will find a function with no parameter. 

The next line is:

[Result= try GetData(1) otherwise null, Page = 1],

This line uses Matt’s original function; however, it throws in an error check.   Essentially, it states ‘try’ to GetData, if it returns with an error, return 
with ‘Null’ in Page 1:

The solution to this problem was produced by a combined effort of Matt 
Mason, his blog post can be found here and Miguel Escobar, whose video 
explains his method well. 

Matt Mason’s method adopts a brute force method where it instructs 
Power Query to run through pages 1 to 10,000 and stop when Power 
Query runs into an error or a ‘null’ value.  He points out that if this 
method is used together with third party software such as Fiddler (more 
on Fiddler later), Power Query will be found trying to evaluate all 10,000 
pages.  Furthermore, if you try Matt’s method now with the newest 

version of Power Query, you may receive an error claiming that you do 
not have access to the database. 

This is where Miguel comes in and adjusts the code a little so that it does 
not adopt the brute force method anymore as well as fix the permissions 
bug that has developed in Power Query.  Building off Matt Mason’s ideal, 
we will only use his ‘GetData’ function and build off that.  

To begin with, let’s open Power Query from Excel and convert Matt’s 
GetData query into a function:

Step 3: Unknown Number of Pages

https://www.mattmasson.com/2014/11/iterating-over-an-unknown-number-of-pages-in-power-query/
https://www.youtube.com/watch?v=vhr4w5G8bRA
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The next line:

each [Result] <> null,

specifics a condition, where the result cannot be null. Or perform this function as long as the Result does not equal to null. 

The next line increments the Page to page 2:

each [Result = try GetData([Page]+1) otherwise null, Page = [Page]+1],

The last line in this function instructs Power Query to display the Result field:

each [Result])

Once we hit ENTER we will see the list of tables:

This is all of the different pages pulled of the domestic gross of 2016 from the Box Office Mojo website.  Notice that Power Query does not try to 
evaluate 10,000 pages. 

Now we go through the table and define each column’s data type.  While this is still a list we can transform this into a table and expand the data:
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Once the table has been transformed we can expand the table.

The expanded table should look something like this:

Closing and loading will not result an error but instead all of the movie data from the year of 2016 from Box Office Mojo.

Now that we have dealt with the page number issue, we can now move on to the final bit…
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Power Query needs some assistance: a software program called Fiddler is one such assistant.  To download this software, please go to Telerik’s 
software page to download Fiddler.  When your PC has finished installing Fiddler, open it and the page should look something like this:

As the prompt “Please select a single Web Session to impact” will require a web browser; we have used Chrome for this example, just because that 
was what we felt like when we took the screenshots. 

So we go back to where we started and navigate to the Hockey statistics website again (URL: www.quanthockey.com/khl/seasons/2017-18-khl-
players-stats.html) and we will start to see some interesting things appearing on Fiddler:

Fiddler takes the source of the URL and displays is it here, so let’s see what happens when we try page 2 of the Hockey Stats.  Fiddler now returns 
with an alternate URL:

It seems to have been broken down into Seasons, and potentially pages too.  Let’s copy it and save it on to an Excel spread sheet to aid us in 
discovering any patterns.  Right click the line of URL and select ‘Copy just URL’.

Step 4: Fiddling with the URL, Fiddle(r) with the URL

https://www.telerik.com/fiddler
http://www.quanthockey.com/khl/seasons/2017-18-khl-players-stats.html
http://www.quanthockey.com/khl/seasons/2017-18-khl-players-stats.html
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After repeating the process, a couple of times, we spot a pattern. Fiddler is able to retrieve the URL and break it down into pages.  This is great news, 
we can finally use this to work with Power Query.

Now for the final part where we combine everything together.

The first step is to create a new Query in Power Query and create a new parameter:

Name the parameter ‘PageNumber’, set it to a Decimal Number type, and give it a current value of 1. 

Now create a new Blank Query and paste the original code from Matt Mason into the formula bar: 

Source = 
 Web.Page(Web.Contents("http://boxofficemojo.com/yearly/chart/?page="  
& Number.ToText(page) &  
"&view=releasedate&view2=domestic&yr=2013&p=.htm")),

Then modify it using the new URL provided from Fiddler:

=Web.Page(Web.Contents("http://www.quanthockey.com/scripts/AjaxPaginate.php?cat=Season&pos=Pla
yers&SS=2017-18&af=0&nat=2017-18&st=reg&sort=P&so=DESC&page=2&league=KHL&lang=en&rnd=167379793
&dt=1"))

We also have to include the PageNumber parameter and the Text.From Power Query function to ensure that it is inserted into the URL as a 
text format.  The following code should replace the page number (in case you were wondering, the ampersand symbols mean concatenate):

="&Text.From(PageNumber)&"

yielding this:

=Web.Page(Web.Contents("http://www.quanthockey.com/scripts/AjaxPaginate.php?cat=Season&pos=Pla
yers&SS=2017-18&af=0&nat=2017-18&st=reg&sort=P&so=DESC&page="&Text.From(PageNumber)&"&league=K
HL&lang=en&rnd=276273473&dt=1"))

Step 5: A Solution
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As you can see, the PageNumber parameter has been linked into the URL.  Power Query will return with a condensed table.  The next step is to select 
the top right ‘Table’ option:

This will expand the table resulting in a table that only imports data from the first page, or the first 50 records.

Now, create a new blank query and copy this code in, it is a modified version of Matt’s GetData function for our purpose:

= (PageNumber as number) => let

        Source = Web.Page(Web.Contents("http://www.quanthockey.com/scripts/AjaxPaginate.php?cat=Season&pos=Players&SS=2017-
18&af=0&nat=2017-18&st=reg&sort=P&so=DESC&page="&Text.From(PageNumber)&"&league=KHL&lang=en&rnd=276273473&dt=1")),

        Data0 = Source{0}[Data],

        #"Changed Type" = Table.TransformColumnTypes(Data0,{{"Rk", Int64.Type}, {"", type text}, {"Name", type text}, {"Age", Int64.Type}, {"Pos", 
type text}, {"GP", Int64.Type}, {"G", Int64.Type}, {"A", Int64.Type}, {"P", Int64.Type}, {"PIM", Int64.Type}, {"+/-", Int64.Type}, {"PPG", Int64.
Type}, {"SHG", Int64.Type}, {"GWG", Int64.Type}, {"G/GP", type number}, {"A/GP", type number}, {"P/GP", type number}})

    in

        #"Changed Type"

The second section of code simply changes the data types accordingly for each column so that you don’t have to do it!  Once entered, rename the 
function to ‘PageData’.

Now to incorporate Miguel’s method, create another blank query and copy this code in: 

= List.Generate( ()=>

[Result= try PageData(1) otherwise null, Page = 1],

each [Result] <> null, 

each [Result=  try PageData(Page) otherwise null, Page = [Page] +1],

 each [Result])

Once entered, change the name of the query to ‘AllData’.
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This time there are no modifications needed in the code, other than to convert this list into a table.

Once Power Query has converted it into a table, we can expand the table:

Expanding the table should yield this result, where Power Query is able to compile the entire list of Hockey players, way beyond 50:
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We can now proceed to ‘Close & Load’.

There you have it, all 829 Hockey Player statistics (as at the time of writing) in one worksheet!

Until Microsoft introduces a new built in feature to circumvent all this nasty coding, there does appear to be little alternative to this common issue.  
If you have a better solution please do let us know at contact@sumproduct.com.

We would like to thank Reza Rad, Miguel Escobar, Matt Mason and Simon Sabin for all contributing to this solution.

Apologies for the delay in reporting these updates, but Microsoft took a while to announce the updates and therefore we missed our newsletter 
production deadlines.  No matter – they have been busy behind the scenes with more updates for Power BI Desktop.  And it’s been worth the wait – 
Q&A finally comes to the party, albeit in Preview mode.  

In summary, here's the latest additions: 

Reporting

	 •	Q&A for report creation (Preview)
	 •	Cross-highlighting for bookmarks
	 •	More bookmark flexibility
	 •	 Field properties pane and field descriptions
	 •	 Scatter visual from x- & y-axis groupings
	 •	High density sampling for maps based on latitude and longitude
	 •	Responsive slicers
	 •	New custom visuals: 
			   o	 Card Browser
			   o	 Table Heatmap
			   o	 Data Image by CloudScope
			   o	 Power KPI Matrix
			   o	 Text Filter
			   o	 ChartAccent – LineChart
			   o	 ChartAccent – BarChart

December 2017 Updates for Power BI Desktop

mailto:contact%40sumproduct.com?subject=
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Analytics

	 •	Drill filters other visuals

Data Connectivity

	 •	Adobe Analytics connector (Preview)
	 •	HDInsight Interactive Query connector
	 •	Data.World connector
	 •	 SAP BW connector improvements: 
	 	 	 o	 Support for connecting to an SAP BW Message Server
	 	 	 o	 Support for Windows Authentication
	 •	 IBM Netezza connector now generally available.

Let’s take a look at each of these in turn.

Q&A for report creation (Preview)

Now this is a good one.  One of the great features of the Power BI Service (more later) is the Q&A feature that lets end users ask questions about 
the data using natural language on bespoke dashboards and get a visual back that answers that question.  Then you could pin those answers to 
the dashboard.  Well now it comes to Desktop, albeit in Preview model.  Double clicking on a blank area of your report page or clicking the ‘Ask a 
question’ button on the Ribbon produces a question box to type your burning question.

Cross-highlighting for bookmarks

There’s two updates for the bookmarking preview this month, the first of which is the ability to bookmark the cross-highlighted state in addition to 
any filters, slicers and other bookmarkable features.  Now that you can bookmark cross-highlighting, these may be accessed easily and the insights 
shared with everyone who uses the reports.

As you type, a visual is created in real-time answering the question and updates as you modify or add to your question.

Once your visual is made, you can use it the exact same way as a normal 
Power BI visual, changing fields around and formatting it to match your 
report’s style.  With Q&A now built into the report experience in this 
way, you can get answers to your questions just by typing them.  That’s 
worth the price of the software alone (it’s free).  It also lets you quickly 
create an entire report without needing to use the field well or list.  

Do note that Q&A is currently a preview feature, so to access this 
highlight you will need to enable it through the ‘Options’ dialog the first 
time you wish to incorporate the feature.  Trust us, this is a cool feature!
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More bookmark flexibility

Given bookmarking is still in its infancy, Microsoft is particularly listening to feedback on the bookmark preview released earlier this year.  Some of 
the early feedback received for bookmarking was that end users wanted more flexibility in what could be bookmarked.  In particular, there were 
suggestions received about the ability to control the types of properties that were bookmarked and what visuals on a page were affected by the 
bookmark.  Consequently, this update has been developed in response to these comments, with two new sets of controls added.

The first control allows you to pick whether the bookmark will apply the “data” properties such as:

	 •	 filters and slicers
	 •	 “visual” properties such as spotlight
	 •	 visibility and / or the page change that moves users to the page that was visible when the bookmark was added.  

These group of properties may be combined to bookmark just what you need.  

The second control lets you pick which visuals the bookmark is applied 
to.  By default, bookmarks apply to the entire page.  However, if you 
want the bookmark to apply to only part of the page, e.g. because you 
divided your page in half to do a side by side comparison, you can now 
do just that.

First, simply set up the bookmark how you want it to look and then 
second, multi-select the visuals you want included in the bookmark.  
Third, you can create or update your bookmark while the visuals are 
still selected.  Then, you “simply” change the bookmark through the 
bookmark’s menu to Selected visuals instead of All visuals and it will 
only apply the bookmark to those visuals you selected. 
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Field properties pane and field descriptions

The field properties pane allows users to change the name and description of a field from the fields list.  This may be accessed by selecting 'Properties' 
from the field menu:

In the pane, the field may be renamed and a description attributed.
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This works like a screen tip or Data Validation Input Message in Excel: once you give a field a description, you can see if anytime by hovering over the 
field in the list:

If there are multiple users editing reports, this is a great way for everyone to understand what fields they should use and how measures are being 
calculated.
The description is also shown if you’re using a connection to an external Analysis Services model.  This means you can see this information from 
centralised IT-developed models if the developer set the description there as well.

Scatter visual from x- & y-axis groupings

Until now, the way to create a scatter visual was to use two measures, one for each axis, and a categorical value in the details bucket to group on.  
With this update, you don’t need to add a category to the details bucket.  Power BI Desktop will instead plot all the x- and y- pairs that you have in 
your model.  To create your scatter visual this way, just pick 'Don’t summarize' as the aggregation type.  This is only an option for numeric columns 
and won’t work for measures.

High density sampling for maps based on latitude and longitude

This update sees Microsoft extend the high-density sampling algorithm, 
which is already supported in scatter and line visuals, to maps using 
latitude and longitude.  This new algorithm will better preserve the shape 
of your data while also surfacing outliers.  To do this, Power BI Desktop 
prioritises showing points that aren’t going to be hidden by neighbouring 
points.  With this change, end users should see a noticeably improved 
experience with any map visuals using latitude and longitude that exceed  

 
 
the data point limit.  Microsoft claim that this sampling algorithm allows 
you to represent a large number of data points without sacrificing 
performance and load time.  We will see!

It’s not mandatory though.  If you would prefer to use the previous 
sampling algorithm or test out the improvements, simply turn off ‘High 
Density Sampling’ in the ‘General’ card of the ‘Formatting’ pane. 
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Responsive slicers

With the new responsive slicers, Power BI Desktop allows you to resize them to a variety of different sizes and shapes, from horizontal to square to 
vertical, and the values in the slicer rearrange themselves as you do.  You can make both horizontal slicers and date and range slicers responsive.  
Both the date and range slicers also have the added benefit of improved touch areas so it's easier to change them with a fingertip (assuming you have 
a touchscreen!).  These have been designed with mobile app solutions in mind.

New custom visuals 

There’s quite a few in this update, so here’s a brief summary of each…

The Card Browser visual is a document set viewer featuring ‘flippable’ (Microsoft believe this is a word!), double-sided thumbnails for 
natural navigation of media collections.  The Preview face of each card renders the headline image, title, and origin of the story with a 
text sample, enabling rapid discovery of documents of interest, e.g.

CARD BROWSER
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Flipping the cards reveals the MetaData face, which lists document properties.  Clicking a card expands it in place for detailed reading:

The Table Heatmap visual allows you to compare data values in an easy and intuitive way, a bit like heat map conditional formatting in 
Excel.  You may give it a category and all the measures you want to compare.  The visual will then colour the matrix in a stepped color 
gradient, which may be customised if required.

TABLE HEATMAP

The Data Image visual by CloudScope displays dynamic web images.  You can pick to crop the image into a circle and to add a border:

DATA IMAGE BY CLOUDSCOPE



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Apparently, this isn’t the fourth instalment of the Keanu Reeves sci-fi franchise.  The Power KPI Matrix visual enables balanced 
scorecards in Power BI and displays an unlimited number of metrics and KPIs in a single, customised list.  Power KPI Matrix is similar to 
the Power KPI custom visual in supporting the creation and display of KPI indicator symbols and values along with current and historical 
trends of actual and target values, but it has the added benefit of the tabular format that allows for an unlimited number of metrics 
and KPIs in a single matrix.  

POWER KPI MATRIX

The Text Filter visual is a search box that can be used to filter all the visual on your report page to any categories in a given field that 
contains the text you specify.

TEXT FILTER
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The ChartAccent visual’s line chart allows you to highlight individual data points, data series, points within a range or even points above 
the average value.  You have fine-grained control over the data label formatting, the ability to define ranges on the axis and the ability 
to annotate the chart with shapes, text, and images.  Each annotation is listed on the top right section of the pane, so you can see the 
actions taken and easily make edits or remove annotations.

Similar to the LineChart!

Right, that’s custom visuals sorted (phew!).  What’s next?

CHARTACCENT – LINECHART 

CHARTACCENT – BARCHART  

Drill filters other visuals

This update adds one of the most popular drill features, the ability for other visuals on reports to be filtered as users drill down into a visual.  Now, 
as you drill down in a given category, you may also filter all visuals on your page by that same category.  This new option is on by default for all new 
reports, but you can turn it off (or turn it on for older reports), through the option in the 'Format' tab.
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Drill filters other visuals

This update adds one of the most popular drill features, the ability for other visuals on reports to be filtered as users drill down into a visual.  Now, 
as you drill down in a given category, you may also filter all visuals on your page by that same category.  This new option is on by default for all new 
reports, but you can turn it off (or turn it on for older reports), through the option in the Format tab.

Adobe Analytics connector (Preview)

This update also sees a new connector for Adobe Analytics.  This connector allows users to easily import and analyse Adobe Analytics data within 
Power BI.  The connector is currently available as a Beta connector in Power BI Desktop.  End-to-end support for this connector in the Power BI 
Service will become available in a few months.

The new Adobe Analytics connector can be found in the ‘Get Data’ dialog, under the ‘Online Services’ category.

After selecting the Adobe Analytics connector, authentication is straightforward, viz.
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Once the connection has been successfully established, users may preview and select multiple dimensions and measures within the ‘Navigator’ dialog 
to create a single tabular output.  As part of this selection, there is also the option to provide any necessary input parameters for the selected items.

After selecting the desired information, users may decide to directly load the query into Power BI Desktop or perform any additional data 
transformations and filters within the Query Editor UX upfront, via the ‘Edit’ option in this dialog.

This connector is in preview, so you will need to enable it through the ‘Options’ dialog the first time you wish to try it.
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HDInsight Interactive Query connector

Another new connector in this Power BI Desktop release is a new connector for HDInsight Interactive Query.  Interactive Query leverages Hive on 
LLAP in Apache Hive 2.1, bringing the interactivity to your complex data warehouse style queries on large datasets stored on commodity cloud 
storage.

The new HDInsight Interactive Query connector can be found under the Azure tab in the ‘Get Data’ dialog:

Upon selecting this connector, users may specify which HDInsight Interactive Server and Database to connect to, as well as the connectivity mode.  
This connector supports both Import and DirectQuery modes.

Once connection details have been provided, users may authenticate using user name / password, then navigate, preview and select one or multiple 
tables from the connected database.
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Data.World connector

In partnership with Data.World, Microsoft has shipped a new connector in Power BI Desktop that allows users to import Data.World datasets into 
Power BI.  The new Data.World connector can be found under the Online Services category in the ‘Get Data’ dialog:

This connector requires users to provide an Owner and Dataset ID and, optionally, a query to run.

After specifying these fields, users will be able to preview the dataset and load it directly into Power BI Desktop or leverage the Query Editor to apply 
data transformations and filters before the data is loaded.

SAP BW connector improvements

There have been a couple of significant improvements to the SAP BW connector in this release, too:

	 •	 Support for connecting to an SAP BW Message Server
	 •	 Support for Windows Authentication.

Brief details are provided below.
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One common request from SAP BW connector users was being able to specify a Message Server rather than an Application Server 
when setting up the connection from Power BI.  Microsoft has responded by adding a new SAP BW Application Server connector under 
the Database category in the ‘Get Data’ dialog:

Windows credentials are now supported when connecting to either SAP BW Application or Message Servers.  The extra Windows 
Authentication option may be found in the ‘Credentials’ dialog after specifying a server to connect to.  This new authentication type 
allows users to connect using the “current user” or specifying “alternate credentials,” as well as their SNC partner name.  The SNC 
library to use may also be specified.

Please note that these two new features for SAP BW are only available in Power BI Desktop at the time of writing.  Microsoft has promised 
support for them in the Power BI service, via the On-premises data gateway, will be added in the future, but has not specified a timeline yet.

This new connector allows users to specify a Server, System ID, Client ID and Logon group for the Message Server to connect to.  Both 
Import and DirectQuery connectivity modes are supported.

SUPPORT FOR CONNECTING TO AN SAP BW MESSAGE SERVER

SUPPORT FOR WINDOWS AUTHENTIFICATION
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IBM Netezza connector now generally available

Finally (we’re glad you made it to here), this update makes the IBM Netezza connector now “GA” (Generally Available”).  This connector has been 
available as a Beta connector in Power BI Desktop since June last year and is supported end-to-end in the Power BI service (via the On-premises data 
gateway) since August.  

The IBM Netezza connector can be found within the ‘Get Data’ dialog, under the ‘Database’ category.  The connector allows you to import data or 
create DirectQuery-based reports on top of IBM Netezza databases.

It didn’t stop in December.  January’s are out too.  So sorry to those who have no interest in this, but we know many of you do like to keep up to 
date!  Here’s the January additions: 

Reporting

	 •	 Show and hide pages
	 •	Control data label background color for Cartesian and maps visuals
	 •	 Increase area used for axis labels in charts
	 •	Bar / column padding control
	 •	 Show dates as a hierarchy (Preview)
	 •	Add an anchor date for relative date slicer
	 •	 Top N selection in Q&A

Analytics

	 •	 Correlation coefficient quick measure

Custom visuals

	 •	 PowerApps
	 •	 TreeViz
	 •	 Funnel with Source by MAQ Software
	 •	Box and Whisker chart by MAQ Software
	 •	Agility Planning Matrix Light
	 •	 Image Grid
	 •	Gantt Chart by MAQ Software

Data connectivity

	 •	 Support for Azure Active Directory authentication for Azure SQL Database & Data Warehouse connectors

Other

	 •	Advanced language settings for the Windows store app.

Let’s take a look at each of these in turn.

Show and hide pages

While creating your reports, you may have needed to hide a page or two 
perhaps because of in-progress work.  You still wanted users to have 
access to other parts of the report.  Hiding pages is also useful when 
you start using drillthrough or creating your own navigation through  

bookmarking, and you don’t want you users to access a page through the 
normal page navigation.

Starting from this update, you can now hide any number of pages you 
want through right clicking the page name and selecting hide.

January Updates for Power BI Desktop
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While you are editing the report, you’ll still see the pages, but they will look different to indicate they are hidden.  You won’t be able to see the pages 
at all when you move to reading mode.

Control data label background color for Cartesian and maps visuals

You can now control the background colour for data labels in Cartesian and map visuals.  This is useful for stylistic changes and readability, especially when 
you have a situation where the data label is midway over a data point.  You can find the option under the ‘Data labels’ card in the ‘Formatting’ pane:

Increase area used for axis labels in charts

If you have a chart where the axis labels are being cut off, previously your only option would be to increase the size of your chart.

That’s not a great option as the report page space is limited, therefore this update adds a maximum size control for the axis to the ‘Formatting’ pane.  
This new slider can be used to increase the percentage of the chart used by the axis labels.
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Bar / column padding control

Another new axis formatting option added is the ability to control the inner padding between bars.  You can make the inner padding up to 50% of 
the bar’s width:

Show dates as a hierarchy (Preview)

For a long time now, Power BI has automatically created a date hierarchy whenever you are using the internal date table.  The problem was that 
you couldn’t see the said hierarchy in the field list.  Instead, this update has created it automatically for you when you drag your data column into a 
visual.  Now, you can see the entire hierarchy in the field list.  You’ll need to turn on the preview feature switch under File > Options and Settings > 
Options > Preview features.

Add an anchor date for relative date slicer

When using the relative date slicer, you may want to start further back in time than the current date (i.e. today).  This is very common whenever your 
data is not complete until a few days later when all sales are finalised and reported into your systems.  You can now do this with the relative date 
slicer by setting an anchor date.  Once you have an anchor date set, the slicer will be evaluated relative to that specific date.  You can set it in the 
date range options in the ‘Formatting’ pane.

This is useful not only because there’s now more transparency about automatically generating this hierarchy, but also because you can now use 
individual fields from the hierarchy in your visuals just by dragging or checking the specific level you are interested in.  Previously, to do this you would 
have needed to put the entire hierarchy into the visual and then remove the levels you didn’t want.

or all the way down to zero to get a histogram effect:
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Top N selection in Q&A

After bringing Q&A to Power BI Desktop in December, Microsoft has continued to improve the natural language engine itself.  You may now ask top-n 
type questions such as "What are my top 3 products by sales?".

Correlation coefficient quick measure

This quick measure is now in the ‘quick measures’ gallery.  It calculates the Pearson correlation coefficient between two measures within a certain 
category, which is a really common statistical measure of how closely related two values are.

or "top manufacturer by NSAT"
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Custom visuals

There’s another raft of visuals in the January update too!

With the new PowerApps custom visual, aside from quickly finding insights in your data, you can take action on it as well.  They allow 
you to build automated workflows.  With the new custom visual, that experience can be embedded in your report. 

The TreeViz custom visual by AutoCont CZ a.s. allows you to display your hierarchical data in a tree-like structure.  You may expand 
and collapse each level and decide how many children data points to show before grouping the smaller ones into a single child group:

POWERAPPS

TREEVIZ
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The Funnel with Source custom visual lets you track any metric 
of interest over various stages along with the source of entry of 
the data point to the funnel.  For example, in the case of sales 
journey data, this visual displays the channel through which 

any lead enters the funnel and then the corresponding journey 
through the various stages of the sales cycle.  You can also filter 
data based on the selection of channel and on the selection of 
any stage of the sales journey.

Box and whisker charts are most commonly used in statistical 
analysis to see the spread of your data.  They consist of two 
parts: the main body called the box and the thin vertical lines 
coming out of the box called whiskers.  The first quartile forms 
the bottom and the third quartile forms the top of the box.  The 

whiskers connect the minimum and the maximum values to the 
box.  In addition to showing median, first and third quartile, and 
maximum and minimum values, the Box and Whisker chart by 
MAQ Software is also used to depict mean, standard deviation 
and quartile deviation.

The Agility Planning Matrix Light by Managility is a matrix visual for planning and budgeting.  Some benefits of this matrix visual are the 
ability to selectively drilldown on specific rows and to display currently applied filters on the visual itself.

FUNNEL WITH SOURCE BY MAQ SOFTWARE

BOX AND WHISKER CHART BY MAQ SOFTWARE

AGILITY PLANNING MATRIX LIGHT
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The jury is out on this one…

The Image Grid custom visual by Fredrik Hedenström is analogous to a word cloud for images.  You may display many images and 
choose for the size to be based on the sort order or the value of a measure.  You can also decide to show them in a grid view instead 
with the top visual to be based on the sort order.

IMAGE GRID

This type of chart is well known and is commonly used for scheduling and management of tasks.  This visual shows additional details 
of the task by providing a grid where one can view more data related to the task and can display the hierarchy of data category.  Also, 
it may be sorted based on any data point of the task.

GANTT CHART BY MAQ SOFTWARE

Support for Azure Active Directory authentication for Azure SQL Database & Data Warehouse connectors

For those using the Azure SQL Database and Data Warehouse connectors, 
there have been many requests to Microsoft to be able to leverage the 
Azure Active Directory authentication in order to connect to these Azure 
services within Power BI.

With January’s update for Power BI Desktop, Microsoft has introduced 
a new “Microsoft Account” option within the Credentials dialog for the 
Azure SQL Database and Data Warehouse connectors, allowing users to 
authenticate using their AAD accounts.
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It should be further noted that support for this new authentication type in the Power BI Service will soon be available too.  Watch this space!

Phew!  Lots of updates there.  But we’re far from finished…

Advanced language settings for the Windows store app

If you’re using the Windows store app, you can now specify the display 
language.  You can also specify the model language separate from the 
display language.  This is useful if you are working for a global company 
and there are people from all over the world consuming and creating 
reports in languages other than the default language the report was 
created in.

You’ll see these new options under the ‘Regional Settings’ tab in the 
‘Options’ dialog.  Changing the application language will ignore the 
Windows default display language and switch to the chosen language.  
Changing the model language will decouple the model language from 
the application language for any newly created reports. (Note that this 
won’t affect the model language for existing reports.)  Changing either of 
these settings requires a restart.
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Yup, same excuse here as for Power BI Desktop December Updates (above).  In summary, here's the latest additions: 

	 •	 Selective publish(ing) for Power BI apps
	 •	 External user distribution with Azure Active Directory B2B
	 •	 Improved workspace management with Premium
	 •	AI-powered app recommendations
	 •	Dashboard on-tile updates
	 •	 E-mail subscriptions for apps
	 •	 Single-sign on for SQL Server, Teradata and SAP HANA
	 •	High availability for gateways and more in the recent on-premises update
	 •	Granular control for Publish to Web.

Let’s take a look at each of these in turn.

December 2017 Updates for Power BI Service

Selective publish(ing) for Power BI apps

Power BI apps allow organisations to distribute a collection of purpose-
built dashboards and reports to a large number of business users and 
empower them to make data-driven decisions.  Since May, when Power 
BI apps were first launched, thousands of apps have been created in 
Power BI.  Microsoft estimates that hundreds of thousands of users have 
used these apps, showing that the snowball is truly rolling (it is very weird 
writing this when it’s 40 degrees Celsius outside!).

This update takes things a step further by releasing one of the most 
requested features: selective publish of content.  Apart from the fact that 
this doesn’t appear to make grammatical sense, what does this mean?

It’s probably best to explain using a hypothetical situation.  Imagine you 
have created a Power BI app that your entire organisation uses to get 
a 360-degree view of the sales pipeline and you are working on adding 
a new dashboard to the app that focuses on sales forecasts.  Your end 

users request a minor improvement to an existing dashboard in the app.  
You would like to make that improvement and update the app without 
publishing the incomplete sales forecast dashboard.

This was not possible until this update.  Previously, with every update of 
a Power BI app, all the content in the underlying app workspaces would 
get published.  However, with this release, you can choose not to publish 
certain dashboards and reports in the app workspace.

To show how this works, in the graphic below, we have an app workspace 
for Sales.  We would like to make a small change to the Executive View 
dashboard and update the app.  The problem is, we do not want my 
incomplete Sales Forecast dashboard to be published to my end users yet.

This update adds new functionality to the content list to do precisely that.

The “Included in app” toggle for this example  
Sales Forecast dashboard may simply be 
turned off: >

The app may then be updated, with the Sales 
Forecast dashboard not be included.  Hence, 
you can make incremental updates to apps 
without publishing any incomplete dashboards 
or reports.
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External user distribution with Azure Active Directory B2B

Improved workspace management with Premium

Dashboard on-tile updates

Continuing with the example above, there might come a situation where 
you want to share the sales app that you created to external users outside 
of your organisation.  Remembering Power BI’s integration with Azure 
Active Directory (AD) business-to-business (B2B) which we reported 

on in December’s newsletter, you can seamlessly distribute Power BI 
apps and dashboards to guest users while maintaining control over the 
internal data.  Recipients will be able to access your content with their own 
organisational identity. 

For those of an IT persuasion amongst you, it’s now easier for capacity administrators (Power BI and O365 inclusive) to assign specific workspaces to 
Power BI Premium.  Instead of bulk assigning workspaces for the entire organisation, there’s more granularity in the control settings.

AI-powered app recommendations

The Power BI AppSource is now combined with AI, which is therefore offering more relevant apps to end users.  Apparently, these suggestions are 
powered by a sophisticated model that takes into account a variety of factors, including the overall popularity of the app, the actions of other users in 
your organisation, and your relationship with those users.  You’d better get on with them then, we suppose.

The latest update does away with the need to experiment with the different icons on the on-tile actions for dashboard tiles.  Microsoft has updated the 
“on-hover” experience to just contain the ellipses and now when they are clicked on, users should benefit from a more intuitive dropdown that describes 
the various actions that can be performed on that tile.
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E-mail subscriptions for apps

Single-sign on for SQL Server, Teradata and SAP HANA

High availability for gateways and more in the recent on-premises update

Granular control for Publish to Web

Back in October, support was added for e-mail subscriptions within Power BI Apps.  This update allows you to install any Power BI app, and then subscribe 
for email updates on any dashboard or report page contained within the app.  You will then be notified of any changes to the data in real time, enhancing 
the impact of your Power BI solutions.

Power BI now leverages Kerberos to support single sign-on (SSO) when 
connecting to certain data sources such as SQL Server, Teradata and 
SAP HANA via DirectQuery.  With SSO configured for these data sources, 
queries will be executed under the identity of the user interacting with 

the service or mobile app.  This means there’s no longer a necessity to 
have shared data caching across different users – each user will be able to 
precisely query the data which they have permission to in the underlying 
data source.

The on-premises data gateway has also been updated.  Now, you may 
group multiple gateway instances together with High availability support, 
trace Mashup engine logs under “Additional logging”, connect to IBM 

Netezza via the gateway, automatically fall back to communicating 
through Azure Service Bus using HTTPS if direct TCP fails and there’s even 
an updated version of the Mashup engine to utilise too. 

Administrators now have more control over Publish to Web in their organisations with two new capabilities:

	 1.		 Administrators may now restrict Publishing to Web to specific security groups.  This is useful if some groups, like PR or Marketing, should be able  
			   to Publish to Web, but this is not allowed for everyone

	 2.		 Administrators can now see all Publish to Web embed codes in their organisation and remove codes as necessary / required.

More next time, no doubt.

Mid-January saw the release of another set of updates for Get & Transform, the versatile features based on the Power Query technology, providing 
fast, easy data gathering and shaping capabilities.

This update adds support for generating ‘Conditional Columns’ transformations as a part of the really useful ‘Add Column From Examples’ feature, 
which can be accessed via ‘Add Column’ tab on the ‘Query Editor’ Ribbon.  By supporting ‘Conditional Columns’ transformations, the following 
scenarios are now unlocked:

January Updates for Get & Transform (Excel 2016) / Power Query  
(Excel 2010 and 2013)   
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Basic Conditional Column

Conditional Column Ranges

Bucketing

It is now possible to define a mapping between values in an input column and the desired output by providing a set of examples. 

With this update, you can define a new column with non-uniform ranges based on an input column.  This new capability is supported for columns where 
the output values do not encode the range boundaries.

Starting with this January release, ‘Add Column From Examples’ also supports what’s known as “bucketing”.  Users may specify the upper / lower 
boundaries of a range for a certain row and Excel will automatically extrapolate to all other rows by using uniform ranges.
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Null Fallback

A very common scenario for ‘Conditional Column’ is using a value from a given column, or the value from a fallback column when the first column value 
is missing.  The ‘Add Column From Examples’ feature now supports this kind of transformation.

Ah, it’s time for my Lord of the Rings impersonation.  What do I mean?  “COLUMN” (try saying it out loud if you don’t understand – this joke is 
precious).  This function returns the column number of the given cell reference.  For example, the formula =COLUMN(D10) returns the value 4, 
because column D represents the fourth column.

The COLUMN function employs the following syntax to operate:

COLUMN([reference])
The COLUMN function has the following arguments:
	 •	 reference: believe it or not, this is optional and represents the cell or range of cells for which you want to return the column number
		  o	 if the reference argument is omitted or refers to a range of cells, and if the COLUMN function is entered as a horizontal array formula, the  
			   COLUMN function returns the column numbers of reference as an horizontal array
		  o	 to enter a formula as an array formula: starting with the formula cell, select the range that you want to contain the array formula.  Press the 	
			   F2 function key and then press CTRL+SHIFT+ENTER.
				      N.B. in Excel Online you cannot create array formulae
		  o	 if the reference argument is a range of cells, and if the COLUMN function is not entered as a horizontal array formula, the COLUMN  
			   function returns the number of the leftmost column
		  o	 If the reference argument is omitted, it is assumed to be the reference of the cell in which the COLUMN function appears
		  o	 The reference argument cannot refer to multiple areas.

Please see our example below: 

The A to Z of Excel Functions: COLUMN
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The COLUMNS function has the following arguments:

	 •	array: this is required and represents an array or array formula, or a reference to a range of cells for which you want the number of columns
	 •	 this is a useful function to employ when you need to keep track of the relative number of columns in an array.  For example, 		
		  VLOOKUP(lookup_value, table_array, COLUMNS(given_range), [range_lookup]) allows you to add or remove columns in the range without 	
		  the relevant column to be returned being affected.

Please see our final examples for this month below: 

Upcoming SumProduct Training Courses

Location Course Date Duration

Brisbane Excel Tips & Tricks 12 Feb 2018 1 day

Melbourne Excel Tips & Tricks 20 Feb 2018 1 day

Melbourne Financial Modelling 21 - 22 Feb 2018 2 days

Perth Financial Modelling 26 - 27 Feb 2018 2 days

Sydney Visual Basic for Applications 12 Mar 2018 1 day

Sydney Power Pivot, Power Query and Power BI 19 - 21 Mar 2018 3 days

Adelaide Financial Modelling 5 - 6 Apr 2018 2 days

Sydney Excel Tips & Tricks 23 Apr 2018 1 day

Sydney Financial Modelling 26 - 27 Apr 2018 2 days

Melbourne Excel Tips & Tricks 30 Apr 2018 1 day

Melbourne Financial Modelling 1 - 2 May 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 7 - 9 May 2018 3 days

This is one of the pillars of Excel’s features.  Yes, the jokes get no better.  This function returns the number of columns in an array or reference and 
should not be confused with the COLUMN function (above).

The COLUMNS function employs the following syntax to operate:

COLUMNS(array)

The A to Z of Excel Functions: COLUMNS
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we focus on the Left 
Arrow key (it’s better not Left!!):

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

Left Arrow Move left one cell

ALT + Left Arrow Back (hyperlink navigation)

CTRL + Left Arrow Select the last cell in the area left

SHIFT + Left Arrow Extend selection left one cell

CTRL + ALT + Left Arrow Intel Chipset: Turn screen +90 degrees; else: move active cell to previous non-adjacent 
area within selection

CTRL + SHIFT + Left Arrow Extend selection down to last cell in area left

SHIFT + ALT + Left Arrow Ungroup

Auckland Financial Modelling 21 - 22 May 2018 2 days

Wellington Financial Modelling 24 - 25 May 2018 2 days

Darwin Financial Modelling 4 - 5 Jun 2018 2 days

Sydney Power Pivot, Power Query and Power BI 18 - 20 Jun 2018 3 days

Sydney Financial Modelling 25 - 26 Jun 2018 2 days

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com
mailto:newsletter@sumproduct.com
mailto:contact@sumproduct.com
mailto:training%40sumproduct.com?subject=
http://www.sumproduct.com/training
http://www.sumproduct.com/thought/keyboard-shortcuts
http://www.sumproduct.com

